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I. INTRODUCTION

1.1 Overview

SpeciesChecker is a piece of software that enables users to enter in, save and modify
simple compositions and have them automatically tested for technical errors. This is
somewhat analogous to a word processor’s spellchecker or a grammar checker. This
software is able to analyze compositions for potential problems and generate output for
the user that indicates what types of problems were detected and where.

1.2 Scope

The types of compositions that can be analyzed are cantus firmi and first through fifth
species two-part tonal counterpoint.

1.3 Intended Users

This software is meant for use by students studying the rudiments of counterpoint. The
software was developed specifically for users writing in the framework of species
counterpoint, so it is of limited utility for people wishing to write in more sophistical
genres of music.

SpeciesChecker is intended to be used primarily in an educational context. Music
students are able to enter their work into the software and have it detect potential
problems for them. This gives them immediate feedback on their work so that they can
learn from their mistakes, and it allows them to experiment with different ideas and see if
they are acceptable. It also helps them by acting as a final proofreading tool to avoid
handing in work that contains careless errors.

The software is also able to randomly generate cantus firmi which students can use as a
base for writing counterpoint exercises.

1.4 Limitations of the Software

Although the music theory relating to species counterpoint is for the most part fairly
standardized, there are still several differing perspectives on certain issues. Opinions on
what is correct and what is not can vary from one ear to another, and some of the
considerations involved depend on period and theoretical perspective. In order to
compensate for this, this software implements certain controversial rules, but allows the
user to disable them if desired. Despite this, however, there is a possibility that some of
the more unusual rules may have been omitted.



A further problem is that many of the rules found in the literature are loose guidelines
rather than absolute rules. Considerations of taste and context are often essential, and
some rules are more important than others. Although this is certainly understandable and
desirable for artistic reasons, it is necessary for all rules to be strictly defined in order for
them to be implemented on a computer. The rules implemented by this software are
therefore more rigorous in some cases than the literature requires. This helps to guard
against problematic areas of compositions being missed because of ambiguities in the
rules.

Despite efforts to take overall context into account where possible, some problems may
still be detected in compositions even though the overall structure of the compositions
may make them acceptable. The user should therefore regard problems that are detected
as areas that may need improvement rather than fatal errors that must be corrected. In
order to facilitate this, SpeciesChecker qualifies relatively minor problems as “warnings”
and more serious problems as “errors.”

Finally, it should be understood that the random generation of cantus firmi is fairly
rudimentary. Although a resultant cantus firmus will not violate the rules selected by the
user in the preferences, this does not necessarily mean that it will be a good line. Also, it
may take a few minutes to generate a cantus, depending on the speed of the user’s
computer.



II. FEATURES

2.1 Error Detection

The software detects technical errors in cantus firmi and tonal two-part species
counterpoint compositions. A message is generated for each error detected, indicating the
rule that was violated and, if appropriate, where the error occurred. The user can analyze
the cantus or counterpoint individually, or can analyze both together, as desired.

2.2 Preferences

The software allows users to disable the application of certain rules. This is to
accommodate users who wish to use different sets of rules. This is useful because there
are several different theoretical perspectives on certain issues in the literature. The
preferences are saved to disk so that they will persist when the program is closed.

2.3 Random Music Generation

The software can randomly generate a cantus firmus that conforms to the set of rules that
are selected in the preferences. This enables users to generate cantus firmi for use in
writing counterpoint exercises.

2.4 Graphical User Interface

The software has a menu and table-based interface that allows the user to enter and edit
compositions using a mouse and/or keyboard shortcuts. The interface uses combo boxes
to prevent the user from being able to enter inappropriate information. The user is able to
add or delete a counterpoint from a given cantus firmi so that the same cantus can be used
in multiple compositions without needing to be reentered.

2.5 Read From File / Save To File Functionality

A specially designed file format is used to allow users to save their work so that they can
review or edit it later.

2.6 Online Help

There is an online help that the user can access to gain general information about the

software, instructions on how to use the interface and explanations of the specific rules
which are used in analyses.



III. INSTALLATION GUIDE

3.1 Compatibility

The SpeciesChecker software is written in Java, which means that it can be run on any
system that has the Java™ Runtime Environment (JRE) installed on it. It is recommended
that it be used with Windows, as it was developed and tested under the Windows 98
operating system and the interface’s appearance is optimized for Windows. However, the
software will run under Linux, Solaris or any other operating system with the JRE
installed on it. It is required that version 1.3 or higher of the JRE be installed.

3.2 Installing the Java™ Runtime Environment

If your system already has the JRE installed, you may skip this section. If not, you will
need to install it in order to run SpeciesChecker. It can be downloaded for free from the
java.sun.com web site. At the time of release of this document, the precise URL is
http://java.sun.com/products/jdk/1.2/jre/download-windows.html.  Choose  the language and
operating system that is appropriate from this site, and then download the JRE.

When the download is complete, follow the given installation instructions. Make sure that
you follow the necessary instructions to make it possible to run Java in arbitrary
directories. Under Windows 98, this means adding an entry such as C:\IDK1.3\BIN; to
your path variable in your AUTOEXEC.BAT file. The necessary instructions will be
provided when you download the JRE.

If you are unsure if you have the JRE installed on your system, you may wish to follow
the instructions in Sections 3.3 and 3.5. If you are able to run SpeciesChecker as outlined
in Section 3.5, then you already have the JRE installed on your system. If not, then you
will need to download and install it, as explained above.

3.3 Installing the SpeciesChecker Program

All of the SpeciesChecker files are contained in the spchk.zip file. The files contained in
this file can be unpacked using WinZip, Stuffit Expander or any other free archiving
utility. The files can be unpacked to any directory that you like on your system.

3.4 Guide to Bundled Files

You will find the following files and directories upon extracting the SpeciesChecker files
from the spchk.zip file:



e ClassFiles - a directory that contains SpeciesChecker program files. You do not need
to use this directory, as all of the necessary classes are also found in the sc.jar.

e Documentation - a directory that contains the SpeciesChecker User Manual, Final
Project Report, Mid-Project Report and Project Outline

e Help - a directory that contains the SpeciesChecker on-line help files in HTML
format

e README.txt - a basic guide to installing and running SpeciesChecker

e SampleCompositions - a directory that contains sample compositions that can be
opened and analyzed with SpeciesChecker

e sc.jar - the SpeciesChecker program file

e SourceCode - a directory that contains the SpeciesChecker Java source code

e SCPref.spr - an encoded file that contains the SpeciesChecker preferences

3.5 Running the SpeciesChecker Program

One of the files that is extracted is called sc.jar. This is the file that should be run in order
to use SpeciesChecker. You can run it either by double clicking on it or by typing the
following line at a command prompt, such as the DOS prompt:

java -jar sc.jar

As an alternative, you may also move into the ClassFiles directory and type the following
from a command prompt:

java SpeciesChecker



IV. USING THE SOFTWARE

4.1 Overview of the Main Window
The main window of the SpeciesChecker interface can be seen in Figure 4.1:

[23SpeciesChecker 1.0 |- [O] ]
File Edit Action Help

TrPE OF COMPOEITION: Fitth species, cantus uppervoice

KEY OF COMPOSITION: A major

METER OF COMPOSITION: 474

LENGTH IN MEASURES: 11
hieasure | Beat | Cantus Pitch |Cantus Reglster| CF Pitch | CF Register | CF Duration | CF Tied |

1 1 A -1 Rest 1 half nottied ahead

1 3 A -1 half tied ahead

2 1 B -1 A -1 half nottied ahead

2 3 G# -1 half nottied ahead

3 1 C# 1 A -1 half nottied ahead

3 3 B -1 quarter nattied ahead

3 4 c# 1 quarter nattied ahead

4 1 F# 1 D 1 quarter nattied ahead

4 2z c# 1 quarter nattied ahead

4 3 A -1 guarter nottied ahead

4 4 B -1 guarter nottied ahead

g 1 E 1 c# 1 guarter nottied ahead

g 2 B -1 guarter nottied ahead

g 3 A -1 half tied ahead

5] 1 A -1 A -1 guarter nottied ahead ||
5] 2 G# -1 guarter nottied ahead |

ARMIMG: This line does not have enough rhythimic variation. Mot mare than raughly a third of a line should consist of measures with only a
Izingle type of rhvthmic note value {i.e. all gquarter notes ar all half notes).
ARMIMNG: Bath the cantus firmus and the counterpaint have their climaxes occuring at the same place. The lines should have their climaxes

occuring at different locations.

ERROR: There is voice overlap in measure 4. A nate in the hottom line cannat move up pastwhere the last note ofthe top line was just
previoushy and vice versa.

FIMISHED CHECKIMG COUNTERPOINT FOR ERRORS.

Figure 4.1: The main window of the SpeciesChecker interface

From top to bottom, the components of the interface are as follows:

Menu Bar: used to cause the software to perform actions
Composition Settings: displays the overall settings of the current composition
Notes Table: allows the user to view and modify the notes in a composition

Analysis Results: displays the results of the analysis of a composition as well as
miscellaneous error messages

4.2 Creating a New Composition

The user can start a new composition by selecting the New Composition command from
the File menu. The user is then presented with the dialog box shown in Figure 4.2:
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Egﬁl:reate Mew Composition

Composition type: Third species, cantus lower voice -

HKey of composition: C major -

Length in measures: 8 -
OK Cancel

Figure 4.2: The Create New Composition dialog box

The user can use this dialog box to select what species the new composition will be in,
whether the cantus firmus is the upper or lower voice, the key of the new composition
and its length. When the OK button is pushed, the user will be returned to the main
window of the SpeciesChecker interface, where he or she can specify the notes of the
new composition. A new composition is automatically filled in with default notes, based
on the species type, as seen in Figure 4.3:

E%Species[ﬁhecker 1.0 H=
File Edit Action Help

TYPE OF COMPOSITION: Third species, cantus lower voice

KEY COF COMPOSITION: & majar

METER OF COMPOSITION: 474

LEMNGTH IN MEASURES: 8

Measure | Beat Cantus Pitch | Cantus Register| P Pitch CP Register | CP Duration CP Tied

1 1 C 1 C 1 fuarer nottied ahead
1 2 C 1 fuarer nottied ahead
1 3 C 1 fuarer nottied ahead
1 4 C 1 fuarer nottied ahead
2 1 C 1 C 1 fuarer nottied ahead
2 2 C 1 fuarer nottied ahead
2 3 C 1 fuarer nottied ahead
2 4 C 1 fuarer nottied ahead
3 1 C 1 C 1 fuarer nottied ahead
3 2 C 1 fuarer nottied ahead
3 3 C 1 fuarer nottied ahead
3 4 C 1 fuarer nottied ahead
4 1 C 1 C 1 fuarer nottied ahead
4 2 C 1 fuarer nottied ahead
4 3 C 1 fuarer nottied ahead ||
4 4 C 1 guarer nottied ahead |

Figure 4.3: Sample new third species composition
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4.3 Editing the Notes Table

Once a composition is created as just described or loaded from disk, the user can modify
it using the notes table. This is done by clicking on the appropriate cell of the table. If the
cell is modifiable (as are all non-empty cells not in the first two columns), a combo box
will appear when the cell is clicked on, from which user can select the new value.

Each row of the table corresponds to a rhythmic location in a composition. The cells in
the first row of the table in Figure 4.3, for example, correspond to information about
notes struck in the first beat of the first measure of the composition. The columns are as
follows:

e Measure: the measure where notes in the given row are struck

¢ Beat: the beat where notes in the given row are struck

e Cantus Pitch: the pitch of the note belonging to the cantus firmus that is struck on the
given beat of the given measure. It is also possible to place a rest at this location by
choosing “Rest” from the combo box rather than a pitch.

o Cantus Register: the register of the pitch specified in the corresponding Cantus Pitch
cell. For example, a C in the Cantus Pitch cell and a 1 in the Cantus Register cell
refers to middle C. A value of 2 in the Cantus Register cell would correspond to the C
an octave above middle C, and a value of —1 in the Cantus Register cell would
correspond to the C an octave below middle C. Values of B and -1 in the Cantus Pitch
and Cantus Register cells would correspond to the B a semitone below middle C, and
a D and a 1 in these cells would correspond to the D a whole tone above middle C.

e CP Pitch: the pitch of the note belonging to the counterpoint that is struck on the
given beat of the given measure. It is also possible to place a rest at this location by
choosing “Rest” from the combo box rather than a pitch.

e CP Register: the register of the pitch specified in the corresponding CP Pitch cell.
This column functions similarly to the Cantus Register column.

e CP Duration: the rthythmic duration of the note belonging to the counterpoint that is
struck on the given beat of the given measure

e CP Tied: specifies whether or not the note belonging to the counterpoint that is struck
on the given beat of the given measure is tied ahead to the next note. It is not
necessary to indicate whether or not a note is tied back, as this is determined
automatically.

The table prevents the user from being able to make certain mistakes. No rhythmic
duration is specified for notes belonging to the cantus firmus, for example, because the
theory requires that these notes must always be whole notes. For similar reasons, it is not
possible to tie notes belonging to the cantus firmus.

An example of all of a fifth species composition is shown in Figure 4.4:
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E%Species[ﬁhecker 1.0 [_ (O] x|
File Edit Action Help

TYPE OF COMPOSITION: Fifth species, cantus lower vaice

KEY CF COMPOSITION: A major

METER OF COMPOSITION: 474

Measure | Beat | Cantus Pitch | Cantus Register|  CP Pitch CF Register | CF Duration CF Tied

1 1 A -1 Rest 1 half nattied ahead
1 3 A 1 half tied ahead
2 1 B -1 A 1 half nottied ahead
2 3 G# 1 guaHer nottied ahead
2 4 F# 1 guaHer nottied ahead
3 1 c# 1 E 1 half nottied ahead
3 3 E 2 half tied ahead
4 1 F# 1 E 2 guaHer nottied ahead
4 2 A 1 guaHer nottied ahead
4 3 D 2 half tied ahead
5 1 E 1 D 2 guaHer nottied ahead
5 2 E 2 gighth nottied ahead
5 25 D 2 gighth nottied ahead
5 3 ] >]| 2 half tied ahead
B 1 A -1 c 4z half nottied ahead ||
fi k] Db : fuarer nottied ahead | =

D

D3

Eh

E

E#

Fh =

Figure 4.4: Sample fifth species composition

The first row of the table shows that the first beat of the piece has an A (the one below
middle C) struck in the cantus firmus, while there is a half rest in the counterpoint on this
beat. The third beat of the first measure has an A (the one above middle C) struck as a
half note that is tied over to another A on the first beat of the second measure. It can be
seen that the user is in the process of altering the pitch of the note in the counterpoint on
the third beat of the fifth bar from a C# to a D. Also, note that notes falling between beats
are given a .5 designation, as is the case with the second eighth note in measure 5 in
Figure 4.4.

As a final example, Figure 4.5 and Figure 4.6 show a sample second species composition,
first in standard musical notation and then as displayed by the software:
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I"] ] . ] . ]
" B | = | = ] = = | Fa
—Ff 7 i
W EJ 1 1 | 1 1 1 1
" T |- I
L% ] O
L3 'H bk [ % ] Fa [ ] Fa
1 L& ] = L% ] o L& ]
g 1F
[¥.]
Figure 4.5: Sample second species composition
E%Species[ﬁhecker 1.0 H=
File Edit Action Help
TYPE OF COMPOSITION: Second species, cantus Iower voice
KEY OF COMPOSITION: D minar
METER OF COMPOSITION: 474
LEMGTH IN MEASURES: 9
Measure | Beat Cantus Pitch | Cantus Register CF Pitch CF Register CP Duration CP Tied
1 1 o] 1 Fest 1 half nottied ahead
1 3 o] 2 half nottied ahead
2 1 A 1 c 2 half nottied ahead
2 3 A 1 half nottied ahead
3 1 G 1 Bhb 1 half nottied ahead
3 3 c 2 half nottied ahead
4 1 F 1 o] 2 half nottied ahead
4 3 F 2 half nottied ahead
a 1 E 1 G 2 half nottied ahead
a 3 E 2 half nottied ahead
5] 1 o] 1 F 2 half nottied ahead
5] 3 o] 2 half nottied ahead
7 1 F 1 A 1 half nottied ahead
7 3 B 1 half nottied ahead
g 1 E 1 C# 2 whole nottied ahead
9 1 o] 1 o] 2 whole nottied ahead

Figure 4.6: Sample second species composition

4.4 Inserting or Deleting Rows

It is sometimes necessary to insert or delete rows in the table, in cases where a note needs
to be added to a beat that is not present on the table or where there is no note struck in
either voice on a given beat. This is only necessary in second and fifth species, since they
are the only species that allow choices as to rhythmic values.'

! Second species compositions allow either a whole note or two half notes in the penultimate bar, and fifth
species compositions allow many different rhythmic combinations. All other species require a whole note
in the final measure, and fixed durations everywhere else. The SpeciesChecker interface automatically
configures the table to meet the requirements of compositions belonging to these species, so the option of
adding or deleting rows is disabled in all but second and fifth species.
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The user can insert or delete rows by choosing the Insert Row or Delete Row commands
from the Edit menu. The Insert Row command gives the user a dialog box to select the
rhythmic location of the new row, and the Delefe Row command simply deletes the row
that is currently selected on the table.

4.5 Opening or Saving Files

The user can open or save compositions using the Open, Save and Save As commands
from the File menu. Only one composition can be open at a time, so the user will be
asked if he or she wishes to save the currently open file if he or she attempts to open or
create a composition if one is already loaded.

4.6 Adding of Removing a Counterpoint

If a cantus firmus is open and the user wishes to add a counterpoint to it, he or she may
choose the Add Counterpoint command from the Edit menu. The user can then choose
the type of counterpoint from a dialog box. The user can also remove the counterpoint
from a given composition, so that a composition containing only a cantus firmus is left.
This can be done by selecting the Remove Counterpoint command from the Edit menu.
This is useful if the user wishes to reuse a given cantus firmus in another composition
without having to reenter it.

4.7 Checking a Composition for Errors

The user can check a composition for errors by selecting the Analyze Composition
command from the Action menu. This generates a list of problems detected in the
Analysis Results area of the main window. This list is composed of two sections: The
first section holds the results of an analysis of the cantus firmus itself, independently of
the counterpoint. The second list consists of errors detected in the counterpoint line itself
and in how the cantus firmus and the counterpoint interrelate.

If the user only wishes to analyze the cantus firmus, or if the composition is made up
solely of a cantus firmus, then the user can select the Analyze Cantus command from the
Action menu. The user can also concentrate the analysis on the counterpoint by choosing
the Analyze Counterpoint command from the Action menu. This will cause the software
to look for errors in the counterpoint line and how it relates to the cantus firmus, and will
omit the independent analysis of the cantus.

The problems that are detected are given one of two labels: “errors” or “warnings.”
Warnings indicate problems that may be relatively minor, and errors indicate problems
that are more likely to be significant.
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4.8 Setting the Preferences

The user may wish to disable some of the rules that the software applies while looking for
problems. This can be done by selecting the Preferences command from the Edit menu.
The user is then presented with the dialog box shown in Figure 4.7.

E%:-‘; Preferences E
Cantus Firmus | First Species |/5|3t:und Species |/Third Species rFuunh Species rFiﬁh Species |
[¥| Check that notes are in correct key

[v] Check that correct note durations are used
[v] Check that notes are struck at correct places
[v| Check for tied notes

[v] Check if rests are present

[¥| Check range of line

[¥] Check for repeated notes

[v] Check horizontal intenvals

[v] Check for leaps from the leading tone

[¥] Check total number of leaps k2
[¥| Check for enough large leaps

[¥| Check for too many large leaps

[v| Check for too many consecutive leaps

[v| Check for consecutive leaps in the same direction
[¥] Check that leaps are filled in

[v| Check that large leaps change direction

[¥] Check that direction is changed after a leap

1]

[v] Check that the first note is the tonic

| Help H Sawve Preferences |

Figure 4.7: Preferences dialog box

The user may then choose to enable or disable any of the rules by clicking on the check
box corresponding to the rule. The tabs at the top of the dialog box allow the user to view
the rules for each of the different types of compositions. Explanations of these rules are
found in Section V of this document. The user may also click on the Help button to check
the definitions of the rules in the on-line help.

The software comes pre-loaded with the preferences configured to apply the rules most
commonly found in the literature. Pressing on the Save Preferences button will save the
currently selected preferences to disk, so that the user will not have to reset the
preferences the next time that the software is run.
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4.9 Automatically Generating a Cantus Firmus

The user can randomly generate a cantus firmus by selecting the Generate Cantus
command from the Action menu. The generated cantus will appear on the table when it is
complete. This may take a few minutes, depending on the speed of the computer that the
software is run on. This cantus firmus will not violate any of the rules selected in the
Preferences Dialog Box, but the user should still be aware that this does not necessarily
mean that it will be a particularly good cantus. A counterpoint can be added to a
generated cantus by selecting the Add Counterpoint command from the Edit menu

4.10 Using the On-Line Help

Selecting the Help Topics command from the Help menu will bring up the Help Dialog
Box. This contains an HTML version of this manual. The user can navigate it by clicking
on any of the links in the text, and can return to the topics page by clicking on the /ndex
button. This dialog box remembers the user’s location in the manual as long as the
SpeciesChecker software is not closed, so choosing the Help Topics command again or
clicking on the Help button in the Preferences Dialog Box will return the user to his or
her last location. Clicking on the OK button in the Help Dialog box will hide the dialog
box.

4.11 Quitting the Program

The software can be closed by selecting the Exit command from the File menu or by
clicking on the x button at the top right corner of the main window.

4.12 Sample Compositions

A number of sample compositions for each species are bundled with the software in
SpeciesChecker format. These are available in the SampleCompositions directory. These
are primarily from examples found in the literature. Depending on what rules are enabled
in the preferences, some problems will be found in most of these pieces. The user can use
these files to gain familiarity with using the SpeciesChecker interface.
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V. GUIDE TO DIAGNOSTIC RULES

5.1 Overview

The rules specified in this section correspond to the rules in the Preferences Dialog box,

where the user may either enable them or disable them. The rules are organized by

species, and the rules for each species are only applied to compositions belonging to that
L2

species.

Certain rules are present in more than one species. Users are able to disable an instance of
one of these rules in one species, but leave it enabled in another, if they wish. Also,
although the titles of certain rules may appear similar in different species, their
descriptions should still be read, since there are sometimes subtle differences between
species.

Some of the rules listed in the following sections are redundant, in the sense that a single
error may be detected by multiple rules. This is to allow users to select between slightly
different rules based on differing theoretical perspectives. The default preferences are set
up to minimize this double counting.

5.2 Rules Imposed by the Interface

The interface does not allow the user to make certain mistakes, in order to prevent him or
her from inadvertently violating the integrity of the software. The user is still, however,
allowed to make many kinds of errors, in order that he or she may learn from mistakes.
Those limitations imposed by the interface are as follows:

e Only pitches between C-2 and B3 are permitted.

e Only whole notes are allowed in cantus firmi, and they must be struck on the first
beat only.

e Notes belonging to a cantus firmus may not be tied.

e The only time a note may be struck on the last measure of a bar is on its first beat.

e Notes may only be struck on the first beats of all measures in first species
compositions.

e Notes may not be struck between beats in third species compositions.

e Notes may only be struck on the first and third beats of all measures in fourth species
compositions.

e Notes may only be struck on beats and directly between beats in second and fifth
species compositions.

e The only rhythmic durations allowed in the counterpoint are eighth notes, quarter
notes, half notes and whole notes.

? Note that the rules relating to cantus firmi are applied whenever the Analyze Composition or Analyze
Cantus commands are selected, irregardless of the species.
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Only one note may be struck at a time in a given voice.

A composition may only have a length of four to twenty measures.

Both voices in a composition must have the same key, and it cannot change during
the piece.

The only permitted time signature is 4/4.

5.3 Diagnostic Rules for Cantus Firmi

Check that notes are in correct key: All notes must belong to the given key, with
two exceptions: 1) if the composition is in a minor key, then the second to last
measure may contain the raised 7th scale degree and 2) if the composition is in a
minor key, then the third to last measure may contain the raised 6th scale degree.
Check that correct note durations are used: Only whole notes can be used.

Check that notes are struck at correct places: A note must be struck on the first
beat of each measure, and notes may only be struck then.

Check for tied notes: Notes may not be tied.

Check if rests are present: Rests are not permitted.

Check range of line: The range of the line should be between a 5th and a 10th.
Check for repeated notes: The same note may not be struck twice in a row.

Check horizontal intervals: The only permitted horizontal intervals are minor
seconds, major seconds, minor thirds, major thirds, perfect fourths, perfect fifths,
minor sixths, major sixths and octaves.

Check for leaps from the leading tone: It is not permitted to leap from the leading
tone.

Check total number of leaps: There should be between two to four leaps in the line.
Check for enough large leaps: There should be at least one leap larger than a third
in the line.

Check for too many large leaps: There should be no more than two leaps larger than
a fourth in the line.

Check for too many consecutive leaps: More than two consecutive leaps are not
permitted.

Check for consecutive leaps in the same direction: Two or more consecutive leaps
in the same direction are not permitted.

Check that leaps are filled in: All leaps larger than a third must be filled in by the
next note.

Check that large leaps change direction: Leaps larger than a forth should move in
the direction opposite to the direction of the motion preceding them.

Check that direction is changed after a leap: All leaps larger than a third must be
followed by a change of direction.

Check that the first note is the tonic: The first note of the line must be the tonic and
it must be on the first beat of the piece.

Check that the last note is the tonic: The last note of the line must be the tonic and
it must be on the first beat of the last bar.
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e Compare first and last notes: If there are no notes lower than the first note of the
line, then the last note of the line must have the same pitch as the first note.

e Check that second to last note is approached properly: The second to last note of
the line may not be approached by a leap larger than a third.

e Check that the last note is approached stepwise: The last note of the line must be
approached stepwise.

e Check that endings are properly treated in minor keys: If the line is in a minor
key, and the second to last note is the seventh scale degree, then this note should be
raised a semitone. If the above condition is true and the third to last note is the sixth
scale degree, then this note should also be raised a semitone.

e Check for properly treated climax: Every line must contain a climax. It is usually
the highest note of the line, but may be the lowest point of the line if the first and last
notes of the line are the highest points of the line. The climax note may not be
exceeded or repeated anywhere in the line. The climax may not be on the first two or
last two notes of the line. The climax may not be on the leading tone in a major key or
the raised seventh scale degree in a minor key.

e Check that a note does not reoccur too often: No note should appear more than
four times in the same register.

e Check rigorously that a note does not reoccur too often: A note should not appear
more than three times in the same register if it is ever used to change direction or is
involved in a skip. A note should not appear more than twice in the same register if it
is used to change direction or is involved in a skip more than once.

e Check interval outlined by a series of notes: The interval between the first and last
notes of a series of notes moving in the same direction should not be dissonant (i.e.
tritone, minor 7th or major 7th).

e Check for too many consecutive stepwise notes: There should not be more than
five consecutive notes without a leap.

e Check number of consecutive notes moving in the same direction: There should
not be more than five consecutive notes without a change of direction.

e Check number of changes of direction: The line should change direction at least
twice.

e Check for repetitions of groups of tones: Lines should not contain more than one
occurrence of the same three pitches occurring consecutively in the same order.

e Check for ornamentation: Lines may not have ornamentation where two pitches are
repeated immediately (e.g. ABAB or BABA).

e Check length of piece: The piece should be between eight and sixteen measures
long.

5.4 Diagnostic Rules for First Species — Counterpoint Line Only

e Check that notes are in correct key: All notes must belong to the given key, with
two exceptions: 1) if the composition is in a minor key, then the second to last
measure may contain the raised 7th scale degree and 2) if the composition is in a
minor key, then the third to last measure may contain the raised 6th scale degree.
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Check that correct note durations are used: Only whole notes can be used.

Check that notes are struck at correct places: A note must be struck on the first
beat of each measure, and notes may only be struck then.

Check that tied notes are used correctly: Notes may only be tied if they have the
same pitch, the duration of a note that is tied ahead must be such that it ends when the
note that it is tied to starts, rests may not be tied and a note that is tied ahead must
have a note ahead of it to receive the tie.

Check for too many consecutive tied notes: Consecutive ties are not permitted.
Check for too many tied notes in total: A line should not contain more than two ties
in total.

Check if rests are present: Rests are not permitted.

Check range of line: The range of the line should be between a 5th and a 10th.
Check for repeated notes: The same note may not be struck twice in a row unless it
is tied.

Check horizontal intervals: The only permitted horizontal intervals are unisons,
minor seconds, major seconds, minor thirds, major thirds, perfect fourths, perfect
fifths, minor sixths, major sixths and octaves. Tied notes are also permitted.

Check for leaps from the leading tone: It is not permitted to leap from the leading
tone.

Check total number of leaps: There should be between two to four leaps in the line.
Check for enough large leaps: There should be at least one leap larger than a third
in the line.

Check for too many large leaps: There should be no more than two leaps larger than
a fourth in the line.

Check for too many consecutive leaps: More than two consecutive leaps are not
permitted.

Check for consecutive leaps in the same direction: Two or more consecutive leaps
in the same direction are not permitted.

Check that leaps are filled in: All leaps larger than a third must be filled in by the
next note.

Check that large leaps change direction: Leaps larger than a forth should move in
the direction opposite to the direction of the motion preceding them.

Check that direction is changed after a leap: All leaps larger than a third must be
followed by a change of direction.

Check that the last note is the tonic: The last note of the line must be the tonic and
it must be on the first beat of the last bar.

Compare first and last notes: If there are no notes lower than the first note of the
line, then the last note of the line must have the same pitch as the first note.

Check that second to last note is approached properly: The second to last note of
the line may not be approached by a leap larger than a third.

Check that the last note is approached stepwise: The last note of the line must be
approached stepwise.

Check that endings are properly treated in minor keys: If the line is in a minor
key, and the second to last note is the seventh scale degree, then this note should be
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raised a semitone. If the above condition is true and the third to last note is the sixth
scale degree, then this note should also be raised a semitone.

e Check for properly treated climax: Every line must contain a climax. It is usually
the highest note of the line, but may be the lowest point of the line if the first and last
notes of the line are the highest points of the line. The climax note may not be
exceeded or repeated anywhere in the line. The climax may not be on the first two or
last two notes of the line. The climax may not be on the leading tone in a major key or
the raised seventh scale degree in a minor key.

e Check that a note does not reoccur too often: No note should appear more than
four times in the same register.

e Check rigorously that a note does not reoccur too often: A note should not appear
more than three times in the same register if it is ever used to change direction or is
involved in a skip. A note should not appear more than twice in the same register if it
is used to change direction or is involved in a skip more than once.

e Check interval outlined by a series of notes: The interval between the first and last
notes of a series of notes moving in the same direction should not be dissonant (i.e.
tritone, minor 7th or major 7th).

e Check for too many consecutive stepwise notes: There should not be more than
five consecutive notes without a leap.

e Check number of consecutive notes moving in the same direction: There should
not be more than five consecutive notes without a change of direction.

e Check number of changes of direction: The line should change direction at least
twice.

e Check for repetitions of groups of tones: Lines should not contain more than one
occurrence of the same three pitches occurring consecutively in the same order.

¢ Check for ornamentation: Lines may not have ornamentation where two pitches are
repeated immediately (e.g. ABAB or BABA).

5.5 Diagnostic Rules for First Species — Both Lines

e Check vertical intervals: The only permitted vertical intervals are unisons, minor
and major thirds, perfect fifths, minor and major sixths, octaves, minor and major
tenths and perfect twelfths.

e Check unisons: Vertical unisons may only be present in the first and last measures of
the piece.

e Check that vertical twelfths are treated properly: Vertical perfect twelfths are
only permitted in the climax of the counterpoint, and they may not leap to or be leapt
from a perfect fifth..

e Check that perfect intervals are approached properly: Perfect intervals must be
approached with contrary or oblique motion. This rules out the possibility of parallel
fifths or octaves.

e Check successive unisons and octaves: Vertical octaves may not be followed by
unisons and vertical unisons may not be followed by octaves.

e Check for too many consecutive identical intervals: More than three consecutive
identical vertical intervals (e.g. four thirds in a row) should not be present.
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e Check for too much consecutive parallel motion: A piece should not have more
than three pairs of notes in a row that move using parallel motion.

e Check leaps from perfect intervals: Notes in the counterpoint that are part of
vertical perfect intervals should not be leapt to or from.

e Check lines for improper simultaneous leaps: If there is a horizontal leap in one
line, then the other line should move stepwise if the leap is greater than a forth or if
the lines move with similar motion.

e Check for simultaneous climaxes: The counterpoint and the cantus firmus should
not have their climaxes occur simultaneously.

e Check for voice crossing: A note in the bottom line may never be above the
corresponding note in the top line and a note in the top line may never be below the
corresponding note in the bottom line.

e Check for voice overlap: A note in the bottom line may not move up past where the
last note of the top line was just previously and a note in the top line may not move
down below where the last note of the bottom line was just previously.

e Check the beginning interval: The first vertical interval of the piece must be a
unison, a perfect fifth or an octave. A perfect fifth is only permitted when the
counterpoint is above the cantus.

e Check the last interval: The last vertical interval of the piece must be a unison or an
octave.

e Check the approach to the last interval: The last interval of the piece must be
approached with contrary motion.

5.6 Diagnostic Rules for Second Species — Counterpoint Line Only

e Check that notes are in correct key: All notes must belong to the given key, with
two exceptions: 1) if the composition is in a minor key, then the second to last
measure may contain the raised 7th scale degree and 2) if the composition is in a
minor key, then the third to last measure may contain the raised 6th scale degree.

e Check that correct note durations are used: Only whole notes and half notes are
permitted. Whole notes are only permitted in the last two measures of the line and
half notes are not permitted in the last measure of the line.

e Check that notes are struck at correct places: All parts of the line must have a note
sounding or be covered by a rest at all times. Multiple notes and/or rests may not
overlap in a single line.

e Check for tied notes: Notes may not be tied.

e Check if rests are present: The only rest permitted is a half rest on the first beat of
the line.

e Check range of line: The range of the line should be between a 5th and a 10th.

e Check for repeated notes: The same note may not be struck twice in a row.

e Check horizontal intervals: The only permitted horizontal intervals are minor
seconds, major seconds, minor thirds, major thirds, perfect fourths, perfect fifths,
minor sixths, major sixths and octaves.
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Check for leaps from the leading tone: It is not permitted to leap from the leading
tone.

Check for enough large leaps: There should be at least one leap larger than a third
in the line.

Check for too many large leaps: There should be no more than two leaps larger than
a fourth in the line.

Check for too many consecutive leaps: There should not be more than two
consecutive leaps.

Check for consecutive leaps in the same direction: Two or more consecutive leaps
in the same direction are only permitted if the following conditions are met: a) the
first leap starts on the first beat of a measure and the second leap ends on the first beat
of a measure and b) the combined interval of the two leaps is consonant (i.e. perfect
fifth, minor sixth, major sixth or octave).

Check for leaps across measure lines: Leaps across measure lines are only
permitted if the leap is a fourth or smaller and the direction of motion is changed
immediately after the leap.

Check that leaps are filled in: All leaps larger than a fourth must be filled in by the
next note.

Check that leaps of a fourth are treated properly: Leaps of a fourth must be filled
in unless the following conditions are met: 1) the note after the leap is approached
stepwise, 2) there is a change of direction following the note following the leap and
3) the leap is in the direction opposite to the direction of motion preceding the leap.
Check that large leaps change direction: Leaps larger than a fourth should move in
the direction opposite to the direction of the motion preceding them.

Check that the last note is the tonic: The last note of the line must be the tonic and
it must be on the first beat of the last bar.

Compare first and last notes: If there are no notes lower than the first note of the
line, then the last note of the line must have the same pitch as the first note.

Check that second to last note is approached properly: The second to last note of
the line may not be approached by a leap larger than a third.

Check that the last note is approached stepwise: The last note of the line must be
approached stepwise.

Check that endings are properly treated in minor keys: If the line is in a minor
key, and the second to last note is the seventh scale degree, then this note should be
raised a semitone. If the above condition is true and the third to last note is the sixth
scale degree, then this note should also be raised a semitone.

Check for properly treated climax: Every line must contain a climax. It is usually
the highest note of the line, but may be the lowest point of the line if the first and last
notes of the line are the highest points of the line. The climax note may not be
exceeded or repeated anywhere in the line. The climax may not be on the first two or
last two notes of the line. The climax may not be on the leading tone in a major key or
the raised seventh scale degree in a minor key.

Check interval outlined by a series of notes: The interval between the first and last
notes of a series of notes moving in the same direction should not be dissonant (i.e.
tritone, minor 7th or major 7th).
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e Check for too many consecutive stepwise notes: There should not be more than six
consecutive notes without a leap.

e Check number of consecutive notes moving in the same direction: There should
not be more than six consecutive notes without a change of direction.

e Check number of changes of direction: The line should change direction at least
twice.

e Check for repetitions of groups of tones: Lines should not contain more than one
occurrence of the same three pitches occurring consecutively in the same order.

e Check for ornamentation: Lines may not have ornamentation where two pitches are
repeated immediately (e.g. ABAB or BABA).

5.7 Diagnostic Rules for Second Species — Both Lines

e Check vertical intervals: Vertical intervals other than unisons, minor and major
thirds, perfect fifths, minor and major sixths, octaves and the multiples of these
intervals are only permitted on weak beats, and must be approached and left with
stepwise motion. Intervals greater than perfect twelfths should generally be avoided.

e Check unisons: Vertical unisons are only permitted on weak beaks, except for on the
first beats of the first and last measures, where they may be present. If they occur on
weak beats, they must be left by stepwise motion in the opposite direction to that by
which they were approached.

e Check that vertical twelfths are treated properly: Vertical perfect twelfths are
only permitted in the climax of the counterpoint.

e Check that perfect intervals are approached properly: Perfect intervals must be
approached with contrary or oblique motion. This rules out the possibility of parallel
fifths or octaves, which are absolutely forbidden.

e Check for parallel perfect intervals on successive strong beats: Parallel fifths or
octaves that occur on successive first beats should be avoided, regardless of the half
note separating them. Although these are permissible occasionally, they should not be
emphasized or used frequently.

e Check for too many consecutive identical intervals: Should not have the same
vertical interval occurring on the first beats of more than three consecutive measures.

e Check leaps from perfect intervals: If there is a perfect vertical interval on the first
beat of a measure, then the counterpoint note should not be leaped to or from. This is
sometimes permissible if the leap is small and the direction of motion is changed, but
it should generally be avoided.

e Check for simultaneous climaxes: The counterpoint and the cantus firmus should
not have their climaxes occur simultaneously.

e Check for voice crossing: A note in the bottom line may never be above the
corresponding note in the top line and a note in the top line may never be below the
corresponding note in the bottom line.

e Check for voice overlap: A note in the bottom line may not move up past where the
last note of the top line was just previously and a note in the top line may not move
down below where the last note of the bottom line was just previously.
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Check the beginning interval: The first vertical interval of the piece must be a
unison, a perfect fifth or an octave. A perfect fifth is only permitted when the
counterpoint is above the cantus.

Check the last interval: The interval of the notes struck on the first beat of the last
measure of the piece must be a unison or an octave.

Check the approach to the last interval: The notes on the first beat of the last
measure must be approached with contrary motion.

5.8 Diagnostic Rules for Third Species — Counterpoint Line Only

Check that notes are in correct key: All notes must belong to the given key, with
two exceptions: 1) if the composition is in a minor key, then the second to last
measure may contain the raised 7th scale degree and 2) if the composition is in a
minor key, then the third to last measure may contain the raised 6th scale degree.
Check that correct note durations are used: Only whole notes and quarter notes
are permitted. A whole note may only be used in the last measure of the line and
quarter notes are not permitted in the last measure of the line.

Check that notes are struck at correct places: All parts of the line must have a note
sounding or be covered by a rest at all times. Multiple notes and/or rests may not
overlap in a single line.

Check for tied notes: Notes may not be tied.

Check if rests are present: The only rest permitted is a quarter rest on the first beat
of the line.

Check range of line: The range of the line should be between a 5th and a 10th.
Check for repeated notes: The same note may not be struck twice in a row.

Check horizontal intervals: The only permitted horizontal intervals are minor
seconds, major seconds, minor thirds, major thirds, perfect fourths, perfect fifths,
minor sixths, major sixths and octaves.

Check for leaps from the leading tone: It is not permitted to leap from the leading
tone.

Check for enough large leaps: There should be at least one leap larger than a third
in the line.

Check for too many large leaps: There should be no more than two leaps larger than
a fourth in the line.

Check for too many consecutive leaps: There should not be more than two
consecutive leaps.

Check for consecutive leaps in the same direction: Two consecutive leaps in the
same direction are not permitted.

Check for leaps across bar lines: Leaps across bar lines are only permitted if the
leap is a fourth or smaller and is in the direction of motion opposite to the direction
of motion preceding it..

Check that leaps are filled in: Leaps larger than a third should be filled in by the
next note.
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Check that leaps change direction: Leaps should generally move in the direction
opposite to the direction of motion preceding them. This is occasionally acceptable,
however, if it is not preceded by more than two or three notes moving stepwise in the
same direction.

Check that the last note is the tonic: The last note of the line must be the tonic and
it must be on the first beat of the last bar.

Compare first and last notes: If there are no notes lower than the first note of the
line, then the last note of the line must have the same pitch as the first note.

Check that second to last note is approached properly: The second to last note of
the line may not be approached by a leap larger than a third.

Check that the last note is approached stepwise: The last note of the line must be
approached stepwise.

Check that endings are properly treated in minor keys: If the line is in a minor
key, and the second to last note is the seventh scale degree, then this note should be
raised a semitone. If the above condition is true and the third to last note is the sixth
scale degree, then this note should also be raised a semitone.

Check for properly treated climax: Every line must contain a climax. It is usually
the highest note of the line, but may be the lowest point of the line if the first and last
notes of the line are the highest points of the line. The climax note may not be
exceeded or repeated anywhere in the line (decoration with a neighbour note is not
considered repetition). The climax must be on a metrically strong beat (the first or
third beat). The climax may not be on the first two or last two notes of the line. The
climax may not be on the leading tone in a major key or the raised seventh scale
degree in a minor key.

Check interval outlined by a series of notes: The interval between the first and last
notes of a series of notes moving in the same direction should not be dissonant (i.e.
tritone, minor 7th or major 7th).

Check number of consecutive notes moving in the same direction: There should
not be more than six consecutive notes without a change of direction.

Check number of changes of direction: The line should change direction at least
twice.

Check for ornamentation: Lines may not have ornamentation where two pitches are
repeated immediately (e.g. ABAB or BABA).

5.9 Diagnostic Rules for Third Species — Both Lines

Check vertical intervals: Vertical intervals other than unisons, minor and major
thirds, perfect fifths, minor and major sixths, octaves and the multiples of these
intervals are only permitted on weak beats and must be approached and left with
stepwise motion, unless they are part of a double neighbour or a nota camiata.

Check unisons: Vertical unisons are not permitted on the first beat of measures,
except in the case of the first and last measures, where they may be used on the first
beats.

Check nota cambiata: The first and third tones of a nota cambiata must always be
consonant. The first tone of a nota cambiata must fall on the first beat of a measure.
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Check double neighbour: The first tone of a double neighbour must fall on the first
beat of a measure, the tone being decorated must be consonant and the motion
immediately after a double neighbour must be stepwise and must continue the
direction of motion. It is also preferable for the upper neighbour to precede the lower
neighbour and for one of the neighbours to be a semitone from the note being
decorated.

Check dissonant neighbour notes: Dissonant neighbour notes on the third beat of
measures should generally be avoided.

Check distance between lines: Vertical intervals greater than perfect twelfths should
generally be avoided

Check that perfect intervals are approached properly: Perfect intervals should be
approached with contrary or oblique motion.

Check for parallel perfect intervals: Consecutive unisons, fifths and octaves are
forbidden.

Check separation between perfect intervals: Two vertical unisons, fifths or octaves
separated by only one tone should be avoided.

Check for parallel perfect intervals on successive strong beats: Parallel fifths or
octaves that occur on successive first beats should be avoided, regardless of the notes
separating them. Although these are permissible occasionally, they should not be
emphasized nor used frequently.

Check for too many consecutive perfect intervals: The same vertical perfect
interval should not occur on the first beats of more than two consecutive measures.
Check leaps from perfect intervals: If there is a perfect vertical interval on the first
beat of a measure, then the counterpoint note should not be leaped to or from. This is
sometimes permissible if the leap is small and the direction of motion is changed, but
it should generally be avoided.

Check for simultaneous climaxes: The counterpoint and the cantus firmus should
not have their climaxes occur simultaneously.

Check for voice crossing: A note in the bottom line may never be above the
corresponding note in the top line and a note in the top line may never be below the
corresponding note in the bottom line.

Check for voice overlap: A note in the bottom line may not move up past where the
last note of the top line was just previously and a note in the top line may not move
down below where the last note of the bottom line was just previously.

Check the beginning interval: The first vertical interval of the piece must be a
unison, a perfect fifth, an octave or a perfect twelfth. A perfect fifth or twelfth is only
permitted when the counterpoint is above the cantus.

Check the last interval: The interval of the notes struck on the first beat of the last
measure of the piece must be a unison or an octave.

Check the approach to the last interval: The notes on the first beat of the last
measure must be approached with contrary motion.
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5.10 Diagnostic Rules for Fourth Species — Counterpoint Line Only

e Check that notes are in correct key: All notes must belong to the given key, with
two exceptions: 1) if the composition is in a minor key, then the second to last
measure may contain the raised 7th scale degree and 2) if the composition is in a
minor key, then the third to last measure may contain the raised 6th scale degree.

e Check that correct note durations are used: All notes must be half notes, except
for the last note, which must be a whole note and must be struck on the first beat of
the last measure.

e Check that notes are struck at correct places: All parts of the line must have a note
sounding or be covered by a rest at all times. Multiple notes and/or rests may not
overlap in a single line.

e Check that tied notes are used correctly: Notes may only be tied if they have the
same pitch, the duration of a note that is tied ahead must be such that it ends when the
note that it is tied to starts, rests may not be tied and a note that is tied ahead must
have a note ahead of it to receive the tie.

e Check for consecutive tied notes: A note may not be tied twice consecutively.

e Check that ties are properly placed: Notes on strong beats may not be tied ahead to
notes on weak beats.

e Check that species is not broken too frequently: A line should not contain more
than eight notes that are not involved in a suspension.

e Check consecutive notes involved in broken species: There may not be more than
two consecutive notes that are not involved in a suspension.

e Check if rests are present: There must be a half rest on the first beat of the line and
this is the only place where a rest may be present.

e Check range of line: The range of the line should be between a 5th and a 10th.

e Check for repeated notes: The same note may not be struck twice in a row unless it
is tied.

e Check horizontal intervals: The only permitted horizontal intervals are minor
seconds, major seconds, minor thirds, major thirds, perfect fourths, perfect fifths,
minor sixths, major sixths and octaves. Tied notes are also permitted.

e Check for leaps from the leading tone: It is not permitted to leap from the leading
tone.

e Check for enough large leaps: There should be at least one leap larger than a third
in the line.

e Check for too many large leaps: There should be no more than two leaps larger than
a fourth in the line.

e Check for too many consecutive leaps: There should not be more than two
consecutive leaps.

e Check for consecutive leaps in the same direction: More than two consecutive
leaps in the same direction should be avoided.

e Check for leaps across measure lines: Leaps across measure lines are only
permitted if the leap is a fourth or smaller and the direction of motion is changed
immediately after the leap.
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e Check that the last note is the tonic: The last note of the line must be the tonic and
it must be on the first beat of the last bar.

e Compare first and last notes: If there are no notes lower than the first note of the
line, then the last note of the line must have the same pitch as the first note.

e Check that the last note is approached properly: The last note of the line may not
be approached by leap and may not be involved in a suspension.

e Check that endings are properly treated in minor keys: If the line is in a minor
key, and the second to last note is the seventh scale degree, then this note should be
raised a semitone. If the above condition is true and the third to last note is the sixth
scale degree, then this note should also be raised a semitone.

e Check for properly treated climax: Every line must contain a climax. It is usually
the highest note of the line, but may be the lowest point of the line if the first and last
notes of the line are the highest points of the line. The climax note may not be
exceeded or repeated anywhere in the line. The climax may not be on the first two or
last two notes of the line. The climax may not be on the leading tone in a major key or
the raised seventh scale degree in a minor key.

e Check for too many consecutive stepwise notes: There should not be more than six
consecutive notes without a leap.

e Check number of consecutive notes moving in the same direction: There should
not be more than six consecutive notes without a change of direction.

e Check number of changes of direction: The line should change direction at least
twice.

e Check for ornamentation: Lines may not have ornamentation where two pitches are
repeated immediately (e.g. ABAB or BABA).

5.11 Diagnostic Rules for Fourth Species — Both Lines

e Check vertical intervals: Vertical intervals other than unisons, minor and major
thirds, perfect fifths, minor and major sixths, octaves and the multiples of these
intervals are only permitted on strong beats when they are involved in a dissonant
suspension, and they are only permitted on weak beats when they are not part of a
suspension (i.e. species has been broken) and are approached and left with stepwise
motion.

e Check distance between lines: Vertical intervals greater than perfect twelfths should
generally be avoided

e Check that perfect intervals are approached properly: If species is broken, perfect
intervals must be approached with contrary or oblique motion. This rules out the
possibility of parallel fifths or octaves, which are absolutely forbidden.

e Check for voice crossing: A note in the bottom line may never be above the
corresponding note in the top line and a note in the top line may never be below the
corresponding note in the bottom line.

e Check for voice overlap: A note in the bottom line may not move up past where the
last note of the top line was just previously and a note in the top line may not move
down below where the last note of the bottom line was just previously.
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Check the beginning interval: The first vertical interval of the piece must be a
unison, a perfect fifth or an octave. A perfect fifth is only permitted when the
counterpoint is above the cantus.

Check the last interval: The interval of the notes struck on the first beat of the last
measure of the piece must be a unison or an octave.

Check the approach to the last interval: The notes on the first beat of the last
measure must be approached with contrary motion.

Check that dissonant suspensions resolve properly: Dissonant suspensions must
resolve downwards by step.

Check series of suspensions: More than three suspensions of the same type
occurring consecutively should generally be avoided.

Check consecutive 9-8 suspensions: Consecutive 9-8 suspensions are not permitted.
Check consecutive 2-1 suspensions: Consecutive 2-1 suspensions are not permitted.
Check consecutive 4-5 suspensions: Consecutive 4-5 suspensions are not permitted.
Check for 7-8 suspensions: 7-8 suspensions are forbidden.

Check for 2-1 suspensions: 2-1 suspensions should be avoided if possible.

Check for enough consonant suspensions: There should be at least one consonant
suspension in the piece.

Check for enough dissonant suspensions: There should be more dissonant
suspensions than consonant suspensions in the piece.

5.12 Diagnostic Rules for Fifth Species — Counterpoint Line Only

Check that notes are in correct key: All notes must belong to the given key, with
two exceptions: 1) if the composition is in a minor key, then the second to last
measure may contain the raised 7th scale degree and 2) if the composition is in a
minor key, then the third to last measure may contain the raised 6th scale degree.
Check for whole notes: A whole note is the only duration permitted in the last
measure of a line and this is the only place where a whole note may be used.

Check that notes are struck at correct places: All parts of the line must have a note
sounding or be covered by a rest at all times. Multiple notes and/or rests may not
overlap in a single line.

Check rhythmic configuration of first measure: The first measure of the line must
contain one of the following rhythmic configurations: two half notes, a half rest
followed by a half note, a quarter rest followed by three quarter notes or four quarter
notes. If the measure is ended with a half note, it may be tied ahead or not tied ahead.
Check rhythmic configuration of other measures: Only the following rhythmic
configurations are permitted in measures other than the first: Measures with four
quarter notes, measures with two half notes with the second not tied, measures with a
half note followed by two quarter notes, measures with a half note followed by a
quarter note a followed by two eighth notes, measures with a quarter note followed by
two eighth notes followed by two quarter notes, measures with three quarter notes
followed by two eighth notes, measures with two quarter notes followed by a tied half
note, measures with a half note followed by a tied half note, measures with a quarter
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note followed by two eighth notes followed by a tied half note, measures with a
quarter note followed by two eighth notes followed by an untied half note and
measures with just a half note.

Check for prolonged use of a single rhythmic value: A single rhythmic note value
(i.e. all quarter notes or all half notes) should not continue without variation for more
than two measures.

Check rhythmic variation: Not more than roughly a third of a line should consist of
measures with only a single type of rhythmic note value (i.e. all quarter notes or all
half notes).

Check for changes of rhythmic configuration: Two consecutive measures with the
same rhythmic configuration are not permitted unless they are made up entirely of
notes with only a single rhythmic value (i.e. all quarter notes or all half notes).

Check eighth notes: Eighth notes must occur two at a time and they must move by
step. A leap to the first eighth note is sometimes permitted, but a leap between the
eighth notes or from the second eighth note is forbidden.

Check that tied notes are used correctly: Notes may only be tied if they have the
same pitch, the duration of a note that is tied ahead must be such that it ends when the
note that it is tied to starts, rests may not be tied and a note that is tied ahead must
have a note ahead of it to receive the tie.

Check for consecutive tied notes: A note may not be tied twice consecutively.
Check that ties are rhythmically correct: Only half notes struck on the third beat of
a measure may be tied ahead.

Check if rests are present: The only rest permitted is either a quarter rest or a half
rest on the first beat of the line.

Check range of line: The range of the line should be between a 5th and a 10th.
Check for repeated notes: The same note may not be struck twice in a row unless it
is tied.

Check horizontal intervals: The only permitted horizontal intervals are minor
seconds, major seconds, minor thirds, major thirds, perfect fourths, perfect fifths,
minor sixths, major sixths and octaves.

Check for leaps from the leading tone: It is not permitted to leap from the leading
tone.

Check for enough large leaps: There should be at least one leap larger than a third
in the line.

Check for too many large leaps: There should be no more than two leaps larger than
a fourth in the line.

Check for too many consecutive leaps: There should not be more than two
consecutive leaps.

Check for consecutive leaps in the same direction: Two consecutive leaps in the
same direction are not permitted.

Check for leaps across bar lines: Leaps across bar lines are only permitted if the
leap is a fourth or smaller and is in the direction of motion opposite to the direction
of motion preceding it.

Check that leaps are filled in: Leaps larger than a third should be filled in by the
next note.
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Check that large leaps change direction: Leaps larger than a fourth should move in
the direction opposite to the direction of the motion preceding them.

Check that the last note is the tonic: The last note of the line must be the tonic and
it must be on the first beat of the last bar.

Compare first and last notes: If there are no notes lower than the first note of the
line, then the last note of the line must have the same pitch as the first note.

Check that second to last note is approached properly: The second to last note of
the line may not be approached by a leap larger than a third.

Check that the last note is approached stepwise: The last note of the line must be
approached stepwise.

Check that endings are properly treated in minor keys: If the line is in a minor
key, and the second to last note is the seventh scale degree, then this note should be
raised a semitone. If the above condition is true and the third to last note is the sixth
scale degree, then this note should also be raised a semitone.

Check for properly treated climax: Every line must contain a climax. It is usually
the highest note of the line, but may be the lowest point of the line if the first and last
notes of the line are the highest points of the line. The climax note may not be
exceeded or repeated anywhere in the line (decoration with a neighbour note is not
considered repetition). The climax must be on a metrically strong beat (the first or
third beat). The climax may not be on the first two or last two notes of the line. The
climax may not be on the leading tone in a major key or the raised seventh scale
degree in a minor key.

Check interval outlined by a series of notes: The interval between the first and last
notes of a series of notes moving in the same direction should not be dissonant (i.e.
tritone, minor 7th or major 7th).

Check number of consecutive notes moving in the same direction: There should
not be more than six consecutive notes without a change of direction.

Check number of changes of direction: The line should change direction at least
twice.

Check for ornamentation: Lines may not have ornamentation where two pitches are
repeated immediately (e.g. ABAB or BABA).

5.13 Diagnostic Rules for Fifth Species — Both Lines

Check vertical intervals: Vertical intervals other than unisons, minor and major
thirds, perfect fifths, minor and major sixths, octaves and the multiples of these
intervals are only permitted on the first beat of a measure when they are tied back.
Dissonant intervals are only permitted on other beats when they are not tied forward
and are approached and left with stepwise motion (unless they are part of a double
neighbour or a nota camiata, in which case there may be a leap between dissonances).
Check unisons: Vertical unisons are not permitted on the first beat of measures
unless they are part of suspensions or are in the first or last measures. Unisons are
only permitted on other beats if they are tied over or are followed by stepwise motion.
Check nota cambiata: The first and third tones of a nota cambiata must always be
consonant. The first tone of a nota cambiata must fall on the first beat of a measure.
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Check double neighbour: The first tone of a double neighbour must fall on the first
beat of a measure, the tone being decorated must be consonant and the motion
immediately after a double neighbour must be stepwise and must continue the
direction of motion. It is also preferable for the upper neighbour to precede the lower
neighbour and for one of the neighbours to be a semitone from the note being
decorated.

Check dissonant neighbour notes: Dissonant neighbour notes on the third beat of
measures should generally be avoided.

Check distance between lines: Vertical intervals greater than perfect twelfths should
generally be avoided

Check that perfect intervals are approached properly: Perfect intervals not
involved in suspensions should be approached with contrary or oblique motion.
Check for parallel perfect intervals: Consecutive unisons, fifths and octaves are
forbidden.

Check separation between perfect intervals: Two vertical unisons, fifths or octaves
separated by only one tone should be avoided.

Check for too many consecutive perfect intervals: The same vertical perfect
interval should not occur on the first beats of more than two consecutive measures.
Check leaps from perfect intervals: If there is a perfect vertical interval on the first
beat of a measure, then the counterpoint note should not be leaped to or from. This is
sometimes permissible if the leap is small and the direction of motion is changed, but
it should generally be avoided.

Check for simultaneous climaxes: The counterpoint and the cantus firmus should
not have their climaxes occur simultaneously.

Check for voice crossing: A note in the bottom line may never be above the
corresponding note in the top line and a note in the top line may never be below the
corresponding note in the bottom line.

Check for voice overlap: A note in the bottom line may not move up past where the
last note of the top line was just previously and a note in the top line may not move
down below where the last note of the bottom line was just previously.

Check the beginning interval: The first vertical interval of the piece must be a
unison, a perfect fifth, an octave or a perfect twelfth. A perfect fifth or twelfth is only
permitted when the counterpoint is above the cantus.

Check the last interval: The interval of the notes struck on the first beat of the last
measure of the piece must be a unison or an octave.

Check the approach to the last interval: The notes on the first beat of the last
measure must be approached with contrary motion.

Check that dissonant suspensions resolve properly: Dissonant suspensions must
resolve downwards by step to the third beat of the measure, even if the suspension is
decorated on the second beat.

Check series of suspensions: More than three suspensions of the same type
occurring consecutively should generally be avoided.

Check consecutive 9-8 suspensions: Consecutive 9-8 suspensions are not permitted.
Check consecutive 2-1 suspensions: Consecutive 2-1 suspensions are not permitted.
Check consecutive 4-5 suspensions: Consecutive 4-5 suspensions are not permitted.



Check for 7-8 suspensions: 7-8 suspensions are forbidden.
Check for 2-1 suspensions: 2-1 suspensions should be avoided if possible.
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VI. ACQUIRING FURTHER INFORMATION

6.1 Other Documents

The following documents may also be consulted for further information relating to the
SpeciesChecker software:

e Project Outline: contains the original plans and objectives of the SpeciesChecker
project

e Mid-Project Report: contains an outline of the original design of the project, along
with technical information relating to it

¢ Final Project Report: contains an overview of the project, what was accomplished,
what problems were encountered, what was learned in the course of the project, an
outline of potential improvements to the software and a bibliography.

The Project Outline and the Mid-Project Report are outdated in some respects, but still
contain some useful information. There is some duplication between the material covered
in the Final Project Report and this document, but it also contains a good deal of
additional information.

6.2 Contact Information

Cory McKay can be contacted at cory@uoguelph.ca for any questions relating to this
project or to report any bugs.



